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Abstrakt:

Prace je zaméfena na zpracovani a vizualizaci mrac¢na bodi ziskanych v podzemnich
prostorech s pomoci totalni stanice Leica MS-50. Vizualizace je zde chapana ve smyslu
zobrazeni, nikoliv ve smyslu vizualnich prostfedkt. Data o rozséhlém sklepnim prostoru
byla ziskdana metodou RTK, méifenim polygonového poiadu a naslednym laserovym
snimanim celého objektu. Mra¢no bodu je reprezentovano nékolika zpusoby, at’ uz
pomoci jednobarevné a vicebarevné hypsometrie nebo jako primét do vodorovné roviny
zobrazeny v technické map¢. DalSimi vizualizacemi jsou zachyceny vypoctené
vzdalenosti mezi laserové naskenovanym mra¢nem bodu a trojuhelnikovou siti (TIN)
fotogrammetricky vytvofeného modelu. Skute¢ny stav podzemnich prostor je v zavéru

prace porovnan s vysledky georadarového méfeni firmy INSET.

Kli¢ova slova:
podzemni prostory, mra¢no bodu, 3D model, TIN, CloudCompare, georadar, sklep,

Radnice

Abstract:

The thesis is focused on the processing and visualization of the cloud of points obtained
in the underground spaces with the help of Leica MS-50 total station. Visualization is
here understood in the sense of display, not in terms of visual means. Data on the
extensive cellar space was obtained by the RTK method, measuring the traverse and
subsequent laser scanning of the whole object. Point cloud is represented in several
ways, whether with monochrome or multicolored hypsometry or as a projection to the
horizontal plane shown in the technical map. Further visualizations capture the
calculated distances between the laser scanned point cloud and the triangulated irregular
network (TIN) of the photogrammetric model. Actual condition of the underground

space is compared to the results of georadar measuring of INSET company.

Keywords:
underground spaces, cloud point, 3D model, TIN, CloudCompare, georadar, basement,
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1. UVOD

Prvnim impulzem pro vznik diplomové prace byla legenda o podzemnich chodbéach
V Radnicich, jez propojuji sklepni prostory jedné strany namésti se stranou druhou.
V prubéhu uplynulych desitek let se v ulici Plzenska vytvotilo nékolik propadi, jez
lakaly par nadSencu k bliz§imu prozkoumani. Tito lidé tvrdi, ze pod silnici vidéli ¢asti
zpevnéného klenutého stropu. Podrobnéji se ale prostor kvili zavalu prozkoumat
nepodatilo. Mésto Radnice projevilo zajem legendu potvrdit ¢i vyvratit a nechalo proto
zpracovat georadarovy pruzkum. Geodetickd méteni podzemnich prostor, jejichz ukdzka
je soucasti této prace, jsou dilezitym podkladem pro piipravu planované rekonstrukce

namesti.

Cile, kterych bych rada ve své diplomové prace dosahla, spocivaji v zaméteni sklepnich
prostor vhodnou geodetickou metodou, dale ve znazornéni moznosti, jak lze ziskana
data zobrazit nejen ve 2D ale i ve 3D a zavérem by mélo byt zhodnoceni interpretace

vybranych zplisobtli zobrazeni pro odbornou a laickou vefejnost.

Jednou z modernich metod sbéru dat, ktera se kvili svym vlastnostem pravé
V podzemnich prostorech ¢asto pouZziva, je laserové skenovani. MnoZstvi bodi, které je
laser schopen naskenovat béhem né¢kolika okamzikd, je pro ¢loveka ldkavym faktorem.
Existuje nemdlo bakalafskych ¢i diplomovych praci, které se touto metodou zabyvaji,
poskytujyi informace o jejich moZnostech a ptfipadném vyuziti a porovnavaji ji
s vyhodami a nevyhodami jinych geodetickych postupti, specidlné také v podzemnich
prostorech. Avsak vétSina jich konéi pravé ve fazi porovnavani anebo jsou piipadné

snahy o vizualizaci dat pouze vedlejsim produktem hlavnich ¢innosti.

Ve své praci bych proto chtéla zacit tam, kde ostatni kon¢i, tj. nabidnout zpisoby, jak
data ziskana z laserového skenovani zpracovat, vizualizovat a ptedat tak prostorové
informace o sklepnich prostorach koncovym uzivatelim a to nejen mistnim obyvatelim
a turistim, ktefi by se diky zptistupnéni do nékterych sklept mohli pfiblizit k legendami

opfedenému podzemnimu méstu.



2. MESTO RADNICE

Radnice jsou mésto se 1700 obyvateli lezici na zapadnim okraji Ktivoklatské vrchoviny
necelych 20 kilometrti severovychodné od Plzné. Dominantou tohoto mésta je kostel

sv. Vaclava, ktery je situovan na namésti Kagpara Sternberka.

Texty této kapitoly vychazi z oficialnich webovych stranek mésta Radnic [1].

2.1. Historie mésta
Jiz v prvnich dochovanych pramenech o Radnicich se mizeme docist, ze se nazyvaly

mésteCkem. AvSak az v roce 1570 Radnice oficidlné ziskaly status mésta.

Do historie se ve vlastnictvi mésta zapsalo nemalo rodi, které si narokovaly pravo na
mésto. Od rodu Lucemburkd, pfes Rozmberky, diky kterym je znakem mésta pétilista
rozmberska riize na stiibrném §titu, az po Sternberky. Ti do mésta pfivedli vyznamné
Ceské osobnosti pocinaje Antoninem Jaroslavem Puchmajerem, ktery zde ptisobil jako
faraf, usiloval o prosazeni ¢eského jazyka. Do Radnic za nim pfijizdé€li 1 Josef Jungmann
a Josef Dobrovsky, kteti podporovali jeho mySlenku. Neziistalo jen u slov a roku 1818
pod protektorstvim Kagpara Sternberka vznikla prvni Ctenafska spole¢nost. Jejim cilem
bylo vybudovani knihovny, jeZ méla obsahovat pievazné Ceské knihy. Jiz zminény
Kagpar Sternberk byl piirodovédcem a jeden ze spoluzakladatelit Narodniho muzea.

Jeho zavéry z oboru botaniky a paleobotaniky jsou platné dodnes.

Mezi osobnosti, které se zapsaly do d&jin mésta, patfi operni pévkyné Gabriela
Roubalové (uméleckym jménem La Boema), cestovatel Josef Kotfensky, spisovatel Petr
Fingal nebo BozZena Kamenickd, znama pod pifezdivkou ,badba radnicka®“. Ta se
proslavila v oboru 1écitelstvi. Byla velmi uznavanou diagnostickou, za kterou piijizdéli
lidé z celé republiky. Na pocest téchto osobnosti jsou na domech na namésti pamétni

desky.

Velkou raritou byla na Radnicku povrchova tézba ¢erné¢ho uhli. Uhli se zde tézilo jiz od
16. stoleti a tézba trvala az do roku 1986. Primysl zde kvetl stejné jako chut’ k pivu —

mezi valkami byly v Radnicich dvé sklarny a dva pivovary.

V soucasnosti je mésto proslulé lokalitou Ov¢in. Jedna se paleontologické nalezisté, kde

Vv poslednich letech intenzivné probihaly paleontologické vyzkumy. Mezi objevy, které
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ve svété nemaji obdoby, patii naptiklad nalez nejvétSsiho vzorku stromovité plavuné
Lpeidodendron lycopodioides (1,3 m) nebo ndlez nejdel$iho otisku vétveného kmene

kordaitu (4 m).

2.2. Domov s pecovatelskou sluZbou
Historii nejen tohoto domu se v Radnicich zabyval zakladatel radnického muzea Josef
Hylak, tidici ucitel zdejsi divéi Skoly. V. muzeu se po ném zachovaly rukopisné
poznamky, z nichz vyplyva, ze prvni zminky o domové se datuji v 19. stoleti. Tehdy byl
dim ¢. 242 (obrazek 1) veden jako pansky, tedy v majetku vrchnosti. Postupem ¢asu byl
ale pfeveden do majetku Zidovskych rodin. V priibéhu sta let se ve vlastnictvi vysttidaly

Ctyii zidovské rodiny.

Od roku 2005 je tento objekt vyuzivan jako domov s pecovatelskou sluzbou.

Obrazek 1: Dim ¢. p. 242
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3. VYUZITE GEODETICKE METODY

Pied zahajenim jakékoliv ¢innosti je vhodné orientovat se V zdkladnich znalostech dané
problematiky, proto jsou Vv nasledujici kapitole vymezeny pojmy, jez budou pouzivany

v dalsich odstavcich této prace, a zminuji se zde i o teoretickych zakladech jednotlivych

metod pouzitych v prib&hu sbéru dat.

3.1. Georadarovy prizkum
Geofyzikalni prizkum formou georadarové metody je =zalozen na vysilani
vysokofrekvenéniho elektromagnetického vinéni do zemského povrchu a sledovani
Casového pribéhu prochazejicich a odrazenych vin v radarovych fezech (obrazek 2).

V radarovych fezech je viditelny prubéh dil¢ich rozhrani ¢i lokalnich nehomogenit [2].

GPR antena T, R,
vzduch :'
.‘.- - Povrch
Vysilany W 4/ Odrazeny
signal Yy fA signal
—— .‘.‘ l.‘.':a :,' P Rozhrani 1
Vo4
/_ —= Rozhrani 2

Obrazek 2: Zjednoduseny zakladni princip georadarového méteni,
kde Ty je vysilaci anténa a Ry je pfijimaci anténa

Dle typu antény jsou do méfeného prostiedi vysilany frekvence v rozsahu od 80 do
1000 MHz. Volba vhodné frekvence se odviji od charakteru zadani. Vyssi frekvence
signalu poskytuje vyssi rozliSeni. Signdl s vysSi frekvenci ale pronikd do menSich

hloubek, nez signal s frekvenci nizsi. [3].

Odrazeny signal se vraci k povrchu zemé a je zaznamendvan pfijimacem pfistroje.
Casova prodleva odrazu je zavisla na hloubce odrazu, relativni permitivité a elektrické
vodivosti materialu a pohybuje se v fadech nanosekund. Nevyhodou této metody je, Ze

rychlost Sifeni radarového signdlu je do jist¢ miry ovlivilovina obsahem vody
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V horninach. Vysoky obsah jilu nebo slané vody Vv usazeninach mize vést ke snizeni
kvality rozliSeni, které je zpusobeno zeslabenim elektromagnetické¢ho signalu, a tedy
omezenim priniku. Mezi vyhody fadime hlavné skutecnost, ze se jedna o nedestruktivni
metodu prizkumu. Dalsi kladnou vlastnosti metody je, ze digitdlni zaznamy

georadarovych dat 1ze mit ve 2D i 3D [4].

Samotny sbér dat lze provadét dvéma zplisoby a to bud pomoci krokového,
nebo kontinudlniho rezimu. V prvnim ptipad¢ se jedna o velmi spolehlivy zpusob, kde se
antény posunuji ve sméru pruzkumu v konstantnich rozestupech. Pro zjednoduseni
meéfeni se antény upeviiuji na vozik. Odecet intervalii konstantni vzdalenosti se pak
provede na méficim pasmu ve sméru trasy pruzkumu. Spolehlivost vysledkii je dana
vysokym rozliSenim a velkou kvalitou dat. Kontinualni rezim sbéru dat snizuje kvalitu

zaznamu. Pfi¢inou je tazeni antény po nerovném povrchu terénu [4].

Vysledkem radarovych méfeni je urCeni anomalii, které mohou upozoriiovat na

podzemni objekty charakteru sklept, $tol, jeskyni, inzenyrskych siti atd.
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3.2. Diilni méFictvi
Dulni méfictvi je samostatnym oborem v geodezii. Prace v hlubinnych prostorech se fidi
vyhlaskou Ceského banského tiadu & 435/1992 Sh. o dilné méfické dokumentaci pii
hornické ¢innosti a neékterych ¢innostech provadénych hornickym zptisobem [5], cCasto
oznacovanou jako banska vyhlaska. Jedna se o polohové a vyskové méreni, tedy
0 vytvoieni meéfické polohové a vyskové sit€. DalSimi Cinnostmi jsou pripojovaci
a usmeérnovaci mereni a vytycovaci a kontrolni mereni, jez se provadi pii otevirani

dulnich d¢€l a ovéfovani spravnosti razby [6].

Ukolem piipojovaciho a usmériiovaciho méfeni je uréeni vzajemné polohy a orientace
dulnich dé€l a objektd na povrchu a v riznych horizontech [7], tj. umoznéni vypoctu
soufadnic podzemniho bodového pole Vv povrchové soufadnicové soustavé — zpravidla

v S-JTSK [6].

Existuje n€kolik zptsobu, jak toto méfeni provést [7]:
- pfipojeni $tolou (vodorovna, tiklonna)
- pripojeni dvéma ¢i vice Sachtami
- pfipojeni jednou svislou Sachtou
o promitanim dvou bodi
o promitanim jednoho bodu a pfenesenim smérniki magneticky nebo

gyroteodolitem

Volba nejvhodnéjsiho zplsobu je zavisla na moznostech vstupu do podzemnich prostor

a na typu samotného podzemniho prostoru.
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3.3. Polygonovy porad
Metoda polygonovych potadl slouzi k urCovani souradnic bod podrobného polohového
bodového pole. Potady obvykle zacinaji a kon¢i na bodech o zndmych soufadnicich
ajejich ukolem je urceni soufadnic mezilehlych bodli prostiednictvim méfeni

vodorovnych vrcholovych thli a délek [8].

Pro presn€j$i urCeni soufadnic se pouziva tzv. trojpodstavcové soustavy, kterd se
(v zékladni sestav¢) sklada ze tiéi stativi, trojice podlozek, dvou hranoli a jednoho
pristroje. Pfed zapoCetim méfeni se na bodé polygonu, kde je postaven stativ
s podlozkou, provede centrace a horizontace. V prubéhu méfeni se pak postupné
zaménuje pristroj s odraznym hranolem (podlozka vSak stale zGstava ptipevnéna ke

stativu). Témito ukony dochazi k eliminaci chyby z centrace pfistroje i cila [8].

Polygonové potady se déli podle délek stran na pofady s kratkymi (50 — 200 m) nebo
S dlouhymi stranami (200 — 1500 m). Z hlediska pfipojeni na dané body se dale
polygonové potfady deéli na oboustranné piipojené a oboustranné orientované,
neorientované (tzv. vetknuty polygon), jednostranné pfipojené a jednostranné
orientované (tzv. volny polygon) a na uzaviené polygony (s orientaci nebo bez

orientace), které zacinaji a kon¢i na stejném bode¢ [8].
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3.4. Trigonometrické ur¢ovani vysek
Jak jiz samotny nazev napovidd, jednd se o metodu zaloZenou na feSeni trojuhelniku

s uvazenim na fyzikalni vlastnosti zemské atmosféry a Zemé.

Me¢éteni vysek ¢i prevySeni vychazi z méfeni Sikmych nebo vodorovnych délek a svislych
uhld (zenitové nebo vyskové). Pii méfeni je potieba uvazit, zda je métena délka kratka
(do 200 m) nebo dlouha (nad 200 m). V ptipad¢ dlouhé délky je nutné brat v potaz vliv
chyby ze zanedbani skute¢ného horizontu a vliv refrakce. Jestlize nelze délku méfit
pfimo, ziskdme ji vypoétem z méfenych uhlli, poptipad¢ také z délek pomocnych
zékladen. Popisovana metoda se pouziva pro uréovani vysky objektu, bodu, prevyseni

dvou bodu apod. [9].

V dal§im textu prace je Casto pouzivan pojem prevySeni dvou bodii (obrazek 3).
PtevySenim rozumime rozdil vySek dvou bodid. Hodnota mize nabyvat kladnych
i zapornych hodnot, podle toho, zda je vyska vychoziho bodu A vétsi nebo mensi nez
cilového bodu B. Abychom ziskali rozdil vySek mezi body A a B, je nutné znat vysku
stroje (vs) a vysku cile (V¢). Z méfenych velicin, jako je zenitovy (z) ¢i vyskovy thel (¢)
asikma (s”) nebo vodorovna (S) vzdalenost, jsme schopni urcit vysku h a z ni pak

vypocitat prevySeni z bodu A bod B, pro které plati [9]:
AHAB :h‘l‘ US_ vc
h=sx*tge=s"*sin¢

h=s%*cotgz=s5s"*cosz

Obrazek 3: Prevyseni dvou bodl
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3.5. Laserové skenovani
Laserové skenovani je technologie vyuzivana pro svoji vlastnost bezkontaktniho
ur¢ovani prostorovych soufadnic velkého mnozstvi bodt v kratkém ¢asovém rozsahu.
Mgéfeni je neselektivni, coz znamend, ze vybér mefenych bodl nezavisi na skenovaném
prostoru, ale pouze na nastaveni nékolika parametri skenovani. Naméfené body jsou
oznacovany jako mracno bodt, jez lze dale zpracovavat. Skener je slozen ze dvou Casti —
skenovaciho mechanismu a laserového dalkoméru. V dalkoméru je zabudovan laser,
ktery vyzatuje velmi kratké zablesky infracerveného svétla. Paprsek vyslany
z dalkoméru se odrazi od povrchu objektu a vraci se zpét. Senzorem je zaznamenan Cas
mezi vyslanim signalu a pfijmem jeho odrazu, z n€hoz je pak zndmym zplsobem uicena
vzdalenost k objektu. Vertikdlni smér emitovaného paprsku urcuje skenovaci
mechanismus. Zména horizontalniho uhlu je zajisténa otaCenim celého pristroje kolem

svislé osy [11].

Principem skenovani je zaméfeni objektu pomoci bodl lezicich v pravidelné miiZzce
S definovanym thlovym rozestupem. Prostorova vzdalenost skenovanych bodii zavisi na
nastaveni hustoty miizky (Ghlovy rozestup mezi skenovanymi body) a na vzdalenosti
skeneru a skenovaného objektu. V piipadé pozemniho skenovani je mozné ze znalosti
polohy skeneru, Sikmé vzdalenosti a vodorovného a svislého uhlu polarni metodou

vypocitat prostorové soufadnice jednotlivych bodu [11].

Parametry dulezité pro skenovani jsou velikost skenovaného prostoru, hustota
skenovani, moznost snimédni objektu digitdlni kamerou, registrace vice odrazii, dosah

paprsku, pozadovana piesnost apod. [13].

Podle umisténi skenovaciho pfistroje se laserové skenovani déli na mobilni pozemni,
mobilni letecké a statické pozemni. V pocatcich se technologie vyuZzivala coby letecka
aplikace pro tvorbu digitdlniho modelu povrchu a ve své pozemni aplikaci naptfiklad na

zjistovani tvara slozitych technologickych zatizeni (potrubni systémy v rafinériich) [10].

V soucasné¢ dobé se metoda pouziva i pro zamétovani fasdd, dokumentace pamatek
Vv oblasti architektury a archeologie, méteni podzemnich prostor apod. Jak jiz bylo vyse
zminéno, spolené¢ se skenovanim mracna bodl je mozné provést 1 snimkovani digitalni

kamerou. Pofizené fotografie je mozné vyuzit k ,obarveni“ bodi. Takto obarvené
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modelu [13].

4. VLASTNI MERENI A VYPOCTY

Stavebnim kamenem diplomové prace je sbér dat, proto budou V nasledujicich
podkapitolach podrobné popsany postupy dilé¢ich méfeni. Razeni téchto &asti je dano

chronologickym postupem v prib&hu méteni.

4.1. Georadarovy prizkum
Texty této kapitoly vychazi ze Zavérecné zpravy Geofyzikalni priizkum pro vyhledavanit

podzemnich objektii firmy INSET s. r. 0. [2] a z praktickych zkuSenosti, které jsem

ziskala pfi Gi€asti na tomto méteni.

Obrazek 4: Profily georadarového prizkumu
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Geofyzikalni prizkum podzemnich prostor metodou georadarového méteni zvolila firma
INSET s.r.o. se sidlem v Praze. Zadavatelem bylo mésto Radnice z diivodu planované
rekonstrukce namésti Ka$para Sternberka. Cilem zakazky bylo vyhledavani p¥ipadnych
podzemnich objektli charakteru starych sklept a Stol, které by se v podzemi nadmésti
Kagpara Sternberka a Dédické ulice mély dle sdéleni zadavatele vyskytovat. Prizkum
byl zaméten na vyhledéani volnych, pfipadné sekundarné zaplnénych prostor. Zajmovymi
Gseky byly: jizni ast namésti K. Sternberka a jizni &ast Plzetiské ulice s piilehlymi
¢astmi ulic Sokolské, U Muzea, Pikovy, U Synagogy, Pivovarské a Dédické. Zminéné
sektory byly vymezeny zadavatelem pted zahajenim prizkumu. Orientaéni pribéh

z4jmovych usekl je vyznacen na obrazku 4.

K povrchovému georadarovému prizkumu byla pouzita aparatura MALA
GroundExplorer (GX) HDR se stinénym anténnim systémem 80 a 160 MHz. Méfeni
probéhla na vSech dil¢ich tisecich vzdy na dvou paralelnich profilech ve vzdalenosti 2 -
5 m vedenych soubézné s osou komunikace. Na obou profilech byl prizkum proveden
Vv konfiguraci antén 160 a 80 MHz. Krokem registrace pro systém 160 i 80 MHz byla
vzdalenost 0,02 m. Hloubkovy dosah georadarovych méfeni pro systém 160 MHz cinil
V této oblasti cca 7 m, pro systém 80 MHz byl dosah az 9 m. Dohromady bylo zméfeno

3 594 m georadarovych profili na celkové délce 898,5 metrti.

Vysledky geofyzikalni prizkumu pro vyhledavani podzemnich objekti ukazaly, ze pod
naméstim pravdépodobné zadné chodby, spojujici obé strany namésti, nejsou. Za to se
vsak projevilo mnoho sklepd, které casteéné zasahuji pod troven chodniku. Od
piipadného mapovani chodeb bylo tedy zcela upusténo a dalsi postupy se soustiedily

pouze na mapovani podzemnich prostor na namésti.

Jako ukéazkovy objekt pro tuto praci byl vybran domov s pecovatelskou sluzbou (namésti
Kaspara Sternberka, ¢.p. 242). Dim je majetkem mésta, coz usnadnilo vyjednavani
0 piistupu do objektu. V zadani diplomové prace je sice uvedeno, ze predmétem méfeni
bude nékolik sklepi, ale soucasti vybraného domu jsou velmi rozsahlé dvoupatrové
sklepni prostory, které jsou pro ovéieni a demonstraci postupii pouzitych v praci

dostacujici.
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4.2. Rekognoskace terénu
Jednim z prvnich kroku praktické ¢asti diplomové prace byla navstéva sklepa. Vytvotila
jsem nacrt podzemnich prostor a pofidila snimky jednotlivych mistnosti sklepa. Téz
jsem zjistila, ze kterych mist by bylo mozné vést polygonovy potad (PP) z podzemi na

povrch. Tyto ukony vedly k rozhodnuti, kudy piesné polygonovy potrad vést.

Jiz v prubéhu mé bakalaiské prace (dale jen BP) [14] bylo zjisténo, Ze se na namésti
nenalézaji body z Databéaze trigonometrickych a zhustovacich bodi (DATAZ), které by
se daly vyuzit pro potieby diplomové prace, proto bylo nutné si pied zahdjenim méteni
bodové pole vytvorit. Body, které jsem stabilizovala v rdmci BP, sice v dob¢ sbéru dat
na diplomovou praci stale existovaly, ale kvili své poloze nebyly vhodné. Byly tedy
zaméteny body nové (obrazek 5) a to aparaturou South S82 GNSS1 Rover metodou
RTK".

E Kokes - [0.20323 - 1:807] - =) X

I3} Soubor Pohled Seznam Vykres Rastr Vypocty Aplikace Nastroje Okna Help

OEE
:

Co chced 7 | ::.Hj

lv=_ 20426020 [X= 106011015 | |204sET [

Obrazek 5: Body zaméiené pomoci GNSS (prostiedi SW Kokes)

! RTK (Real Time Kinematic) — ,.kinematické méfeni provadéné v realném &ase. Mezi referenéni stanici

a mobilnim pfijima¢em GNSS musi existovat komunikaéni kanal, umoziiujici pfenos pottebnych dat* [15]
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Méfeni bylo provedeno celkem Ctyfikrat, kdy minimalni casovy interval mezi
jednotlivymi métfenimi byl Sest hodin. Volba bodii zavisela na pocatecnim a koncovém
bodu PP, ktery byl na zaklad¢ ptedchozi rekognoskace sklepti zvolen jako oboustranné
orientovany a oboustranné pfipojeny PP. Celkem bylo zamétfeno 8 bodi — 4 body PP
(4001, 4019, 4020, 4030), které se nachazeji nad zemi, a 4 body orientace (5001, 5002,
5003, 5004).

4.3. Polygonovy poiad a trigonometrické urcovani pirevyseni
Pro ucely této prace, kdy se do sklepnich prostor 1ze dostat pfes chodbu pifimo z ndmésti
a pomoci dvou oken se opét ptipojit k povrchovému bodovému poli, je mozné piipojeni
pomoci polygonového pofadu. Byl tedy zvolen zplsob pfipojeni Stolou
(viz kapitola 3.2). Jak je jiz zminéno v kapitole 4.2, méfilo se nejlep$im mozny

zptisobem, a to oboustranné orientovanym a oboustranné piipojenym PP,

Tento typ polygonu zacind a kon¢i na

X 5002

znamych bodech a z kazdého tohoto bodu je
cileno na minimalné jeden bod orientace, u
néhoz jsou soutadnice téZ znamy. Jsou tedy
provadéna nadbytecnd méfeni, kterd slouzi
bud’ jako kontrola méfenych veli¢in a
vypoctd, anebo pro zptesnéni vyslednych

soutadnic [8].

Zacatek PP byl na bodé 4001 avedl do
chodby domova s pecovatelskou sluzbou
(bod 4002), odkud bylo jiz moZné vést

polygon piimo do sklepnich prostor na bod - —
Obrazek 6: Polygon - 1. ¢ast

4003. Celkem byly zaméteny 3 polygonové

potady — prvni vedl Z bodu 4001 na bod 4020, odkud byla méfena orientace na bod 5004

(obrazek 6).
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Dalsi polygon byl méfeny z bodu 4003 (orientace na bod 4004) a pokracoval pies bod
4025 a 4026 opét zpatky na povrch k bodu 4030 (obrazek 7).

;‘ 5002 7 5002

Obrazek 7: Polygon - 3. ¢ast Obrazek 8: Polygon - 3. ¢ast

Tteti PP (obrazek 8) je vyznacen barvou modrou a vedl od bodu 4025 az do druhého
podzemniho podlazi k bodu 4037. Vsechny body PP byly stabilizovany hieby — dle
potieby byl pouzit bud’ maly, nebo velky hieb.

Pro presnéjsi vysledky méfeni byla pouzita trojpodstavcova soustava (viz kapitola 3.3).
Vzhledem k vétveni polygonu bylo vsak zapotiebi vice nez tii stativi a podlozek —
pfesnéji sedm. Urychlil se tim proces méfeni, jelikoZ bylo mozné stativy ponechat na
misté a vratit se k nim az pii méteni dal$iho sektoru sklepa, takze méteni nezdrzovalo
opakované centrovani a horizontace stativii. Odraznych hranolt by se hodil stejny pocet.
Vzhledem k tomu, ze existuji rizné typy odraznych hranolt a kazdy ma jinou souctovou
konstantu, kterou stroj musi mit zadanou Vv pribéhu meéfeni, protoze s ni pracuje. Pii
méfeni byly pouzity jen dva odrazné hranoly Leica, jez byly pofizeny se strojem Leica
MS50, snimz byla provadéna vSechna méfeni. Hranoly jsme pak pienaseli dle
aktualnich potieb, coz bylo o dost jednodussi nez fesit, na ktery hranol zrovna cilime,

a prepsat podle toho hodnotu souctové konstanty.

Meteni ve sklepé sebou neslo nékolik malych problémd, které mohly mit vliv na
vysledky méteni. Hlavnim problémem bylo nedostatecné (v nékterych ¢astech dokonce

zcela chybéjici) osvétleni, které pro presné cileni na hranol nepostacovalo a bylo nutné
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na ter¢ ruén¢ svitit baterkou. Tento problém byl ¢asteéné vyfeSen osvétlenim nitkového
ktize. Dal§im problémem byly nezpevnéné mékké podlahy, které negarantovaly pevné
umisténi stativii. Tato pfekdzka se dala minimalizovat pouze opatrnym piechazenim
kolem postavenych stativii. Museli jsme se téz vyrovnat s rozdilnymi hodnotami teplot
a vlhkosti. Ve sklepé byla stala teplota — pfi prvnim méfeni, které probihalo na konci
biezna, byla teplota 6 °C, pfi poslednim (v polovin¢ dubna) byla teplota 9 °C. Relativni
vlhkost se blizila 100 % (ve druhém patie sklepi vlhkost kondenzovala na sténach),
kdeZto pii méfeni na povrchu, kde na stativy svitilo slunce, se teplota v prubéhu méfeni

meénila, coz zpusobilo deformaci stativu a zmény horizontace a centrace stroje.

Pii mé&feni PP (obrazek 9 a 10) byly méfeny také zenitové uhly, ze kterych se pak diky
znalosti nadmoiské vysky na bodech zaméfovanych metodou RTK, daly vypoditat vysky

vSech bodu ve sklepé pomoci trigonometrického ur¢ovani vysek.

Obrazek 9: Méfeni PP na stanovisku
4026

Obrazek 10: Pohled na schody do
druhého podzemniho podlazi
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4.4. Vypocty namérenych dat
Podkapitola strucné popisuje postup vypoctli souiadnic bodového pole ziizeného ve
sklepnich prostorach domu €. p. 242. Pouzité postupy a vztahy jsou podrobné popsany

naptiklad v diplomové praci Bc. Dany Vaskové roz. Duskové [16].

Pro vypocet souradnic mefenych bodi byl pouzit software Kokes, ve kterém byly
vSechny soufadnice vypocteny pomoci vyrovnani sit¢. Terénni meéfeni bylo sice
rozdéleno na tii polygony, ale zpisob vypoltu vyrovnanim sité se jevil z hlediska
presnosti vyslednych soutadnic jako vyhodnéjsi. Pfed importem dat do programu bylo
ale jesté¢ nutné poupravit zapisnik, ktery obsahoval pfebyte¢né informace, a struktura

neodpovidala forméatu, ktery je Koke§ schopny nacist.

Vypocet soufadnic byl rozdélen do dvou fazi. Jednalo se o vypocet polohového
a vyskového vyrovnani. V ptipadé obou vypoctl bylo nutné nckterd méfeni vynechat
a nezahrnovat je tak do zpracovani dat. Protoze byl k dispozici nadbytecny pocet méfeni,

bylo mozné identifikovat zjevné chybna méfeni, kterd pak pro vypocet nebyla pouzita.

Duivodu, pro¢ néktera méfeni byla vynechana, bylo hned nékolik. Jednalo se napiiklad
0 méfeni mezi stanovisky 4030 a 4001, kde na vysledky mél vliv svit slunce, nebo
naopak, doslo k chybnému cileni v nedostate¢né osvétleném prostoru. At uz se jednalo
0 tmavé Casti sklepeni nebo o méfeni venku za tmy. Hranol byl sice osvétlovan, ale
napiiklad mezi stanovisky 4020 a 5004 probihalo méteni za zhorSenych podminek (tma,
vitr, mraz, snih), a mohlo tedy dojit k nepfesnému cileni. Dal§im moZnym divodem,
pro¢ nékterd méfeni byla vyloucena z vypoctli, mohlo byt cileni na orientace. Hranol
nebyl na té€chto stanoviscich upevnén ke stativu, ale byl figurantem drZen v ruce
S pomoci stojanku, coz pii opetovném méfeni na téchto bodech zpiisobilo drobné
odchylky. Diisledkem vSech téchto piekdzek byly nesrovnalosti pfi vypoctech, které

byly eliminovany odebiranim méfeni zatiZenych chybami.
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[3

Pti zpracovavani namétenych dat bylo zjisténo, Ze v pfipad¢ nastavovani tzv. ,,setupu’
na novém stanovisku, kdy je potfeba zaméfit alespon jednu orientaci, stroj sice ulozi obé
dvé namétené polohy dalekohledu, ale ve vysledném zapisniku se objevi pouze primér
téchto hodnot. Takovato redukce neni zadouci, a proto, pokud méfi¢ chce zachovat obé

hodnoty, musi po nastaveni setupu zacilit na danou orientaci znovu ve dvou polohéch.

Pfed samotnym vypoctem byly body rozdéleny na body pevné a opérné. Mezi pevné
body patiil bod 4001 a bod oznacovany jako 2432, Jedna se o body, které do vypocta
vstupuji jako body hlavni a podle nichz se vypocty fidi. Ostatni body, které byly
zaméteny aparaturou GNSS, byly brany jako opérné. Hodnota soutadnic téchto bodu se
pii vypoctech uvazovala jen jako pomocnd a ne jako ta, podle které by se sit’ méla

deformovat.

2 Celé &islo bodu je 000920022430 a jedna se o zhutovaci bod s nazvem Radnice — kost. Kalvdrie.
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4.5. Laserové skenovani
Celkem bylo skenovano z 18 stanovisek (obrazek 11), a to opét s pomoci totalni stanice
Leica Nova MSS50. Poloha vSech stanovisek byla pfedem uréena vypocltem sité
(kapitola 4.4). Jako orientace na stanoviscich byly pouzity dalsi body sit¢.

Obrazek 11: Prehled stanovisek, ze kterych bylo provadéno laserové skenovani

Pro nastaveni orientace na stanovisku nabizi totalni stanice nékolik moZnosti. Ukazalo
se, ze puvodné pouzivany zpisob ,,Orientace na znadmy bod“ znéjakého divodu
nefunguje. Stroj sice orientaci ulozil, ale zcela odliSnym a neodivodnitelnym smérem,
nez jakym se ocekavalo. Pfi skenovani byla tedy pouzita metoda ,,Znamy bod zpét*“, coz

se ukézalo jako spravna volba.

Pfed kazdym skenovanim bylo jeSté¢ potieba definovat hustotu skenovani, kterd se
odvijela od nastaveni Sikmé délky a horizontadlniho a vertikalniho rozestupu
skenovanych bodl. Po zadani téchto udajl si stroj sdm vypocte kromé vertikalniho uhlu
1 horizontdlni uhel, o ktery se v pribéhu skenovani konstantné¢ otaci kolem své osy.
Nastaveni hustoty 1ze i pomoci pfimého definovani horizontalniho uhlu, ale tato varianta
vyslednou hustotu mrac¢na bodl. V ptipad¢ stanovisek, ze kterych mély byt snimany
veétsi prostory (ohranicené vzdalenéjSimi st€nami), byly hodnoty nastaveny na 5 m, 0.05
m a 0.05 m (Sikma délka, h. rozestup, v. rozestup). Jednalo se o stanoviska p4, p7, p8,
P9, pl0, 4004, 4025, 4026, 4036, 4037. Takto nastavené parametry znamenaji, Ze objekt

vzdaleny od skeneru 5 m bude méfen v rozestupech 5 cm jak ve sméru horizontalnim,
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tak vertikdlnim. Pokud by se vzdalenost zvysila na 10 m, rozestup bodii by byl 2x vétsi.
V ptipad¢ ostatnich stanovisek (p1, p2, p3, p3, p6, 4003, 4006, 4024), které snimaly jen
blizké stény v ulickach sklepa, bylo nastaveni Sikmé délky zménéno na hodnotu 3 m.

Oba rozestupy zustaly zachovany jako v ptedchozim ptipadé.

Porovname-li tato dvé nastaveni na objektu vzdaleného napiiklad 15 m, bude v prvnim
piipadé skenovan s rozestupem bodu 15 cm, ve druhém piipadé s rozestupem 25 cm. Od
toho se také odviji doba skenovani, ktera v pfipadé hust§iho mra¢na bodi byla 18 min,

Vv ptipad¢ fidsiho mra¢na pouze 10 min.

Obrazek 12 ukazuje vysledné mra¢no boda zobrazené v programu CloudCompare.

Obrazek 12: Mracno bodi v prostiedi CloudCompare

Pred vlastnim laserovym skenovanim byly z n€kterych stanovisek zaméteny vlicovaci
body. Jednalo se o body napiiklad na sténach, schodech ¢i potrubnim vedeni, které byly
oznaceny ¢ernobilym papirovym teréikem. Tyto body nasledné slouzily Ing. R. Fialovi,

pro vytvoreni fotogrammetrického modelu sklepa.
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Stejn¢ jako vétSina laserovych skenerti tak i totalni stanice Leica MS-50 umoziiuje
vytvofeni panoramatického snimku pfed zahajenim skenovani mracna bodu. Tato funkce
byla vyuzita pouze na jednom stanovisku. Doba snimani byla cca 1 h 20 min a kvalita
vysledné textury byla kviili nedostate¢nému osvétleni velmi nizka, jak je mozné vidét na
obrazku 13. Rozhodla jsem se tedy, ze se snimky ze stanice pofizovat nebudou, protoze

délka snimkovani nebyla adekvatni k vysledné kvalité fotografii.

i EE

SRR NG

D e

Obrazek 13: Panoramaticka fotografie nasnimana totalni stanici

4.6. Shrnuti
Mefické prace, které zahrnovaly zamétfeni bodit pomoci GNSS, vyty€eni polygonového
poradu, nasledné dométovaci prace, laserové skenovani a fotografovani celého sklepa,
probihaly ve ¢tyfech dnech (37 h). Béhem toho bylo zaméteno 8 bodi metodou RTK,
15 bodti polygonového poradu a 10 dalSich stanovisek pro laserové skenovani, které
byly zaméteny rajonem z PP. Protoze by méteni ve sklepé za vySe popsanych podminek
bylo v jednom ¢lovéku prakticky nerealizovatelné, spole¢né se mnou se na méfeni
podilel vedouci mé prace Ing. R. Fiala, Ph.D., ktery zaujal roli figuranta. V této kapitole
bylo téz popsano, jakymi chybami mohlo byt méfeni zatiZzeno a jak tyto chyby vznikly.
Chybna méfeni byla z vypoctii eliminovana a body PP a body ur¢ené rajonem z PP byly
vypocteny vyrovnanim sit€¢. Stalo se tak ve dvou fazich — zvlast' bylo vypocteno

polohové a zvlast’ vyskové vyrovnani sité.
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5. ZPRACOVNANI ZISKANYCH DAT

V piedchézejici kapitole byly popsany Cinnosti vedouci k ziskani georeferencovaného
mracna bodu reprezentujiciho sklepni prostory domu €. p. 242. V této ¢asti se zamétime
na popis ¢innosti, problémil a jejich feSeni, které souviseji se zpracovanim ziskané¢ho

mrac¢na boda.

5.1. Mraé¢no bodu

Minimalni vzdalenost pro skenovani objektii:

Kombinace totalni stanice a laserového skeneru je sice z finanéniho hlediska mnohem
vyhodngjsi, ale nese to s sebou nevyhodu v délce doby skenovani. Zatimco u skeneru se
tisice bodli naskenuji za par vtefin, u kombinované totalni stanice se pohybujeme

V fadech minut.

Dalsi, vétsi nevyhodou, je minimalni vzdalenost, na kterou je ptistroj schopny skenovat.
Tato negativni vlastnost nesouvisi konkrétné s kombinovanym strojem, ale je to obecny
problém laserovych skenerii. Nékteré skenovaci stroje jsou schopné snimat objekty uz
od vzdalenosti 40 cm (Leica ScanStation P20), ale to jsou jen vyjimky. Primérna
minimalni vzdalenost ¢ini cca 1,4 m, avSak totalni stanice, se kterou jsme méfili, ma
moznost zamé&fit objekty vzdalené nejméné 1,5 m od stroje. Z vySe uvedenych informaci
je tedy patrné, Ze problém, se kterym se setkdvame, neni u laserovych skenert

neobvykly.

Vzhledem k tomu, Ze podstatnou ¢ast sklepniho prostoru tvotily tizké chodby nebo nizké
stropy mistnosti, limitovana minimélni vzdalenost byla velkou piekdzkou a bylo nutné
vytesit zpiisobené komplikace jiz pfi méfeni v terénu. S ¢im vSim bylo nutné pocitat, na
co bylo potfeba dat si pozor a jak byly problémy feSeny, je podrobnéji popsano

a vizualizovano na obrazcich v nadchazejicim textu.
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Reseni problému s minimalni vzdalenosti:

Aby mohly byt vSechny ¢asti naskenovany V dostatecném rozsahu, spocivalo feSeni
minimalni vzdalenosti skenovanych objekti ve zhusSténi podzemniho bodového pole
uréen¢ho PP dalSimi body zamétenymi z PP jako rajony, které dale slouzily jako
stanoviska pro skenovani. Diky témto stanoviskim bylo mozné uzké chodby a nizké

stropy naskenovat, a to slozenim z né¢kolika mensich mrac¢en boda (obrazek 14).

Obrazek 14: Jednotliva mracna spojena do vétsiho celku
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Jak jiz bylo dfive zminéno, ne vzdy byly problémem jen tzké chodby. Nékdy nastal
problém i ve velkych prostorech (obrazek 15). Vidime zde stanovisko 4025, které kvtli
vedeni polygonového potfadu bylo velmi blizko rohu mistnosti. Body namétené z toho
stanoviska jsou obarveny cCervené. Je ziejmé, Ze v blizkém okoli stroje na tomto

stanovisku nejsou naskenovany zadné body. Toto ,slepé“ misto bylo nasledné

nasnimano z podrobnych bodu p6 a p7.

Obrazek 15:Problematika blizkych objektil

Problém s minimalni vzdalenosti se také tykal oblasti pod stativy, jak zndzoriiuje

obrazek 16.

Obrazek 16: Slepa mista v oblasti stativu
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Podrobngjsi ukazka, jak byla feSena ,,slepa mista, je uvedena na obrazku 17 a hlavné na
jeho detailni Casti (obrazek 18). Jsou zde barevné odliSena dvé stanoviska — Cervena
barva zna¢i body nasnimané z podrobného bodu pl0 a modra barva urcuje body
naskenované z bodu polygonového potradu s ¢islem 4026 (piehled stanovisek naleznete
na obrazku 11). N¢kterd mista jsou snimana pouze z jednoho mista (barva pouze Cervena
nebo pouze modra), ale vétSina sklepnich prostor byla vytvofena piekryvy téchto
jednotlivych mracen, ¢imz byla zaruCena dostate¢nd hustota bodl. Diky barevnému
odliSeni je mozné pozorovat, jak bylo diilezité spravné rozvrhnout rozmisténi stanovisek,

aby byl cely prostor kompletné naskenovan.

Obrazek 17: Barevné odliSeni stanovisek

Obrazek 18: Barevné odliSeni stanovisek — detail
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Zména hustoty mracna bodii:

Jak jiz bylo zminéno v kapitole 4.5, se zvétSujici se vzdalenosti mezi strojem
a snimanym objektem se snizuje hustota mrac¢na bodl. Tato skuteCnost je patrna na

obrazku 16 i na obrazku Obrazek , kde Cervena barva jesté vice podtrhuje zminovany
fakt.

Obrazek 19: Zména hustoty mracna bodi se zvySujici se vzdalenosti od stroje
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Nedokonalosti mracna bodii:

Na obrazcich 20 a 21 jsou znazornény nedokonalosti mra¢na bodu, ke kterym doslo
i pfes peclivé planovani polohy stanovisek tak, aby byly v§echny povrchy naskenovany
ze vzdalenosti vétsi, nez 1,5 m. Jedna se o stisnéné a Spatné piistupné Casti sklepa, kde

se nepodarilo vytesit problém s minimalni vzdalenosti pro skenovani.

Obrazek 20: Oblast chybéjicich bodu (1)

Obrazek 21: Oblast chybéjicich bodi (2)
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Dalsi drobnou nedokonalost nachdzime ve vzdjemné poloze dvou mracen bodd, a to ze
stanovisek p10 a 4026. Na obrazku 22 a 23 jsou v ramec¢ku zvyraznéna jednotliva mista,
kdy na sebe dil¢i mracna nedoléhala. Tento jev byl patrny pouze mezi t€émito dvéma
mracny. Pfic¢inou mohla byt velmi mékka a sypka puda v misté stanoviska 4026 (body

oznaceny ¢ervenou barvou).

Obrazek 23 Nedoléhavost (ivou fnraéen (2)
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5.2. Tvorba modelu v programu Agisoft PhotoScan
Podzemni bodové pole a dalsi podrobné body (celkem 68 bodl) byly pouzity jako
vlicovaci body pro tvorbu 3D modelu vytvoteného z 1940 snimkii. Fotografie byly
zhotoveny kamerou SJCAM SJ4000. Poiidil a v programu Agisoft PhotoScan je
zpracoval vedouci diplomové prace, ktery ma s programem vice zkuSenosti. Vysledkem
byl 3D model sklepa s texturou (obrazek 24 a 25). Princip tvorby a postup prace je
uveden v mé bakalatské praci v kapitole 8.2 [15].

Obrazek 24: Vysledny model ze softwaru Agisoft

Obrazek 25: Textura vytvofeného modelu
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Takto vytvofeny model je svym vzhledem lédkavy hlavné pro laickou vetejnost.

Nasledujici obrazky ukazuji nékolik pohledl na interiér vytvoieného modelu.

Obrazek 26: Snimek interiéru FGM modelu - pohled ze stanoviska 4025

Obrazek 27: Snimek interiéru FGM modelu - pohled ze stanoviska p5

Obrazek 28: Snimek interiéru FGM modelu - pohled ze stanoviska p9

36



5.3. Tvorba modelu v programu CloudCompare
Vytvoteni celistvého modelu z mracna bodt spocivalo ve dvou krocich a to ve vypoctu
normal a spojeni jednotlivych bodd. Oba postupy budou nyni detailnéji popsany,
predtim bude ale jest¢ ukédzano, jak sloucit dil¢i mrac¢na do jednoho celku. Dil¢imi

mracny se rozumi mracna ziskana z jednoho stanoviska.

Spojeni mracen bodii:

Viechny ¢&asti, které chceme B EE—
sjednotit, ozna¢ime (obrazek 29)

ajednim kliknutim na ikonu e T

[~1 (Merge multiple clouds) se j ﬂ%’v'

dil¢i mracna slou¢i. Soufadnice |;

bodi jsou georeferencované, proto = .
pii spojovani jednotlivych mracen Obrazek 29: Spojeni mracen bodd

nebyla nutna identifikace

vlicovacich bodu.

Vypocet normal:

Vypocet normal je jednim ze ¢tyf krokt tzv. Poissonova algoritmu (vice v bakalaiské
praci H. Kubickové [17]), kterym je vysledny model zrekonstruovan. Ve vétvi
databazového stromu bylo nejprve nutné oznacit vloZzené mra¢no bodu (obrazek 30).
Diky tomuto jednoduchému tkonu se jiz zobrazila moznost normaly vypocitat. Jak jsem
zjistila, barva normal je defaultné nastavena na barvu Cernou, je proto vhodné zménit

zabarveni mra¢na bodt, aby vypocitané normaly byly od boda dobfte identifikovatelné.

Obrazek 30: CloudCompare - vétev databazového stromu
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Pomoci menu Edit -> Normals -> Compute (obrazek 31) se dostaneme k tabulce, kde je
potiebné zvolit spravné nastaveni parametrti vhodnych pro vypocet normal. Nastaveni

pro vypocet je patrné z obrazku 32.

€ CoviComen 21l i EEmms e
File Edit Tools Display Plugins 3DViews Help Surface approximation
.b;;, I Colors » B o L o Local surface model
N M | » k - - | Neighbors
DE — . Compu-te use scan grid(s) whenever possible min angle |1.00 =
& Octree » Ivert orid(s) angle [1.00 F
. Grid » T el b @ use octres radius |0.253528 Auto
[ O] )
Mesh 3 TrEaIhE N Orientation
11 Plane » Use scan grid(s) whenever possible
Clear @ Use preferred orientation
+ Sensors b ) Use Minimum Spanning Tree kin=5 [+
Scalar fields 4
"'_"}‘_" Waveform 3
4+
L4 Clone
B Merge
Obrazek 31: Vypocet normal Obrazek 32: Nastaveni parametra

Provedené nastaveni potvrdime tlacitkem ,,OK*, program jiz sam vSe zpracuje a ¢ernou
barvou zobrazi vypoétené normaly, které jsou vzdy znatelné pouze zjedné strany

nahledu na mra¢no nebo model obecné.

Normadly by pro nase ucely mély sméfovat dovniti mracna bodl. Pokud tomu tak nent,
body invertujeme a to opét vyuzitim menu Edit -> Normals -> Invert. Nyni je jiz mozné

ptistoupit ke spojeni bodii do celistvého modelu.
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Tvorba modelu:

Jakmile jsou vypocitané normaly, lze jiz vytvofit i 3D model a to nasledujicim

zpusobem: Plugins -> Poissons Surface Reconstruction.

o2

depth. Na zaklad¢ tohoto udaje se odviji uroven detailu vytvofeného modelu — ¢im vyssi
je tato hodnota, tim detailnéjsi model je. S rostoucim stupném detailu ale roste i velikost
vysledného souboru. Je tudiz vhodné najit kompromis mezi postacujici urovni detailu
a velikosti vytvofeného modelu. Pro ptfedstavu jsou na nasledujicich obrazcich 33 a 34
znazornény dvé turovné detailu (Octree depth = 8 a 16). Pro ucely této prace byla zvolena
hodnota 16.

Obrazek 34: Model - Octree depth = 16
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6. ZPUSOBY INTERPRETACE DAT

Hlavnim cilem diplomové prace bylo zndzornit namétfend data charakterizujici
prostorovy podzemni objekt, co nejvice zplisoby a s co nejvetsi vypovidaci hodnotou,
jak pro laické uzivatele, tak pro odborniky. V nasledujici kapitole jsou shrnuty zptsoby,

kterymi byl tento cil naplnén.

6.1. Hypsometrie
Pro zdiraznéni vyskovych pomért sklepniho prostoru byly na principu kartografické
metody zvané hypsometrie® vytvoreny dva barevné modely. Princip tvorby byl v obou

ptipadech stejny a lisi se pouze odliSnym znazornénim nadmoiské vysky.

Postup vytvoreni barevné skaly:

Export coordinates to SF
V databazovém stromu si opét

., . i Expart = O z
oznacime objekt, ktery chceme
Warning, already existing SF(E) with same name wil be overwritten
upravovat, nasledné klikneme na Cancel

nabidku Edit -> Scalar fields -> Obrazek 35: Export coordinates to SF

Export coordinate(s) to SF(s).

Otevie se okénko (Vviz obrazek 35) a zaskrtneme jednu z nabidek na zakladé toho, podle
které osy chceme barevnou skalu vytvofit. V tomto ptipadé, kdy chceme vizualizovat

ménici se nadmotskou vysku, volime osu ,,Z%.

Properties

Pokud se model po kliknuti na | |Preperty State/Value ~
,OK® barevné nezméni, je nutné | |Neme Mesh
Visible
H Mearmals
ve vlastnostech objektu || omenz)

Colors ¥ reB -

Naone

Box dimensions ‘ RGE
8

zkontrolovat, zda je v poloZce

Color zvoleno Scalar field

:’('

namisto RGB (obrazek 36). D Yiazal "

Obrazek 36: Polozka Colors

3 Hypsometrie = ,kartografickd technika zndzornéni terénniho relié¢fu na map€ pomoci
vrstevnic a ploSného vybarveni jednotlivych vyskovych vrstev mezi nimi; znazornéni
nadmoiské vysky v mapach metodou vyplnéni barevnych ploch.“[15]

40



Vlastni barevné upravy probihaji pod
ikonou 1!5'_1; (Color Scale Manager).
V nastaveni lze vybrat, zda budou
hodnoty reprezentovany relativné nebo
absolutné, dale jaké barvy bude Skala
obsahovat a je mozné pridat i popisky
k barevnému  vyjadfeni. Jak  bylo
barevné  méfitko  nastaveno  pro

vicebarevnou hypsometrii, je vidét na

obrazku 37.

Jednobarevna hypsometrie:

(@ Color Scale Editor

Current | VicebarevnaHypsometrie

Mode |absolute ¥ |Rename

Save

2=z

Delete | | Copy | New

—

Selected slider

) Color - Value |0.000000

Custom labels (one value per ling)

375.695600
382730000
384700000

Close

Obrazek 37: Nastaveni barevné Skaly

Na obrazku 38 je reprezentovana nadmoiska vySka jednotlivych bodi formou

jednobarevné hypsometrie. Volba barvy byla velmi subjektivni — jako zakladni témbr

jsem zvolila hnédou, protoze mné asociuje zeminu, coz K podzemnim prostorim dle

mého nazoru patii. ZvySovani sytosti zvolené barvy charakterizuje snizovani nadmorské

vysky, do které sklep zasahuje, a umocnuje tim tak hloubku (temnotu), ve které se

sklepni prostory nachézi.

Ciselna stupnice byla zvolena s ohledem na minimélni a maximalni hodnoty nadmoiské

vysky, ktera byla ve sklepé zaznamenana. Hodnoty vysek mezi extrémy jsem zvolila

S metrovym rozestupem.

Nadmorskd
vyska [m]

384.70

383.00
382.00
381.00
380.00
379.00
378.00
377.00
375.69

Obrazek 38: Jednobarevna hypsometrie
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Vicebarevna hypsometrie:

Druhy zpusob, ktery jsem pro interpretaci dat zvolila, vychazi z hodnoty nadmotské

vysky na povrchu. Jedna se o primér vySek dvou boda (4001, 4030), jez se nachazi na

chodniku prfed domovem S pecCovatelskou sluzbou. Pro reprezentaci byla zvolena

divergentni kvantitativni stupnice, avSak vybér vhodné barevné Skéaly byl opét velmi

subjektivni. Modré zabarveni méa pfipominat chlad, ktery se zvétSuje s postupnym

v

klesinim do nejnizSich prostor sklepeni. Naopak barva cervend symbolizuje

teplo/teplej$i polohu. V legend¢é jsou na linearni stupnici uvedeny pouze extrémni

hodnoty a kyzena vyska povrchu (obrazek 39).

Nadmofiska
vyska [m]
384.70

382.73

375.70

Obrazek 39: Vicebarevna hypsometrie (1)

Pro zdiiraznéni barevné Skaly, odraZejici vySkové poméry ve sklepeni, byla odstranéna

vlastnost stinovani modelu, ktera mu dodava na plasti¢nosti (obrazek 40).

—

Nadmorskd
vyska [m]
384.70

382.73

375.70

Obrazek 40: Vicebarevna hypsometrie (2)
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Zménime-li perspektivu a podivame-li se na primét modelu do vodorovné roviny, je
mozné pii pohledu shora vidét tii barevné odliSené stupné (obrazek 41). Jedna se
0 vysku stropti, kdy Cervena oblast znaci vstup do sklepa, odkud je nutné do kterékoliv
Casti sejit po schodech do prvniho podzemniho patra (svétle modra barva). V jednom
ktidle rozsahlého sklepa lze sestoupit i do druhého podzemniho poschodi (tmavé
modrd). Nejenze jsme diky tomuto nahledu schopni urcit vysku stropti jednotlivych
Casti, ale je mozné pozorovat i pribéh stropni klenby. Napiiklad na detailnim
obrazku 42 v rdmecku ,,A“ je patrny nahly pokles stropu pii prechodu mezi dvéma
mistnostmi. Dilkaz toho, Ze se jedna o klenbu a ne o rovny strop, vidime v ramecku ,,B*
na totozném obrazku nebo na obrazku 41. Modra barva se zde od kraje smérem ke stfedu

plochy méni v Sedivy odstin, coz znaci zvySujici se nadmotskou vysku.

Nadmofiska
‘-- - vyska [m]
‘ R | 384.70
\ 382.73
A
e
375.70

Obrazek 41: Pramét do vodorovné roviny — pohled shora

Obrazek 42: Pribeh stropni klenby
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Podivame-li se na pramét zdola (obrazek 43), je mozné pozorovat vysku, ve které se
nachézeji podlahy jednotlivych pater. Pfi detailnim ndhledu na vstupni cast sklepa

(obrazek 44) si 1ze pov§imnout postupné zmény vysky jednotlivych schodd.

Nadmofiska
vyska [m]
384.70

382.73

375.70

Obrazek 43: Pramét do vodorovné roviny - pohled zdola

Obrazek 44: Detail na rozdilnou sytost barvy stupnd schodisté
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6.2. Zobrazeni sklepa v technické mapé
Jednim ze zplsobli znazornéni mra¢na bodu je zobrazeni primétu sklepa do technické
mapy meésta. Technickou mapu poskytla firma INSET, kterd pro mésto Radnice

provadéla georadarovy priizkum namésti a jeho okoli.

Pro ptevedeni mra¢na bodi do podoby polygonu vyznacujiciho priimét sklepa, ktery je

mozné dale zobrazit v technické mapé, byl pouzit nasledujici postup:

Mrac¢no bodi bylo v programu CloudCompare zredukovano natolik, aby zdstaly jen
body definujici tvar primétu sklepa. Tento vybér byl vyexportovan ve formatu .shp
anasledn¢ importovan do multiplatformniho geografického informacniho systému
(QGIS). Poté cinnost pokracovala ve vytvoreni nové liniové shapefile vrstvy, ktera diky

spojeni vybranych lomovych bodu charakterizovala primét sklepnich prostor.

Graficky vystup firmy INSET byl ve formatu .dwg, jenz byl s pomoci konvertoru Teigha
File Converter vyexportovan jako format .dxf. Tento soubor bylo mozné nasledné
naimportovat do QGISu, kde byl zobrazen spole¢né s pfipravenou vrstvou prumétu

sklepa.

Vysledek, na kterém je zobrazena technicka mapa a primét sklepa si Ize prohlédnout na
obrazku 45, z né¢hoz je ziejmé, Ze nad sklepem vedou elektricka vedeni (zobrazena
zeleng a fialov€) a vodovod (zobrazeny modie). V tésné blizkosti sklepa je také sloup

vetejného osvétleni (Cerveny symbol lampy).

I prr h

Obrazek 45: Zobrazeni primétu sklepa v technické mapé mésta
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Porovname-li skute¢nost, ze se celé druhé podzemni patro nachazi pod urovni chodniku,
s daty naméfenymi pomoci georadaru (obrazek 46), kdy modra linie znaci prubch
georadarovych profilii a zeleny polygon znazornuje nalezené anomadlie, je mozné
pozorovat urCitou shodu, mezi existujicim podzemnim objektem a georadarovym
nalezem. V zavérecné zpravé firmy INSET je uvedeno, ze méfeni indikovalo
vyznamnou anomalii spadajici do kategorie A/B, kdy kategorie A zna¢i nehomogenni
useky zemniho prostiedi s pravdépodobnou pfitomnosti podzemnich objektd s dutinami
a kategorie B symbolizuje nehomogenni useky zemniho prostfedi s lokaln¢ omezenou
ptitomnosti dutin / podzemnich objekti s dutinami. Odhad hloubky uloZeni se pohybuje
kolem 4,5 m pro strop. Z provedenych méfeni vyplyva, ze vyska stropu druhého
podzemniho patra sklepa (377,5 m) je ve skute¢nosti 5,1 m pod trovni terénu (382,6 m).
Prestoze se vysledky zcela neshoduji, je uréeni polohy i hloubky anomalie v podstat¢

spravne.

\

Obrazek 46: Srovnani primétu sklepa s nalezenou anomalii
— vyznacena zelenym polygonem
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6.3. 3D katastr
V soucasné dob¢ je velmi aktualni problematika 3D katastru, jehoz cilem je zachyceni
vlastnickych vztaht v situacich, kdy se jeden objekt nachazi pod jinym ve vertikalnim
sméru. Pro definovani a spravovani pozemkii ve 3D byla Mezinarodni organizaci pro
normalizaci (ISO) vyvinuta norma ISO 19152: Geograficka informace — Model domény
Sprava pozemkt (CSN EN ISO 19152, 2012), ktera je navrhem konceptualniho datového
modelu pro ucely katastru nemovitosti. Jako nejvyhodnéjsi zpiisoby reprezentace
3D prostorovych objekti se jevi reprezentace na polygonech zaloZend a na topologii

zalozena. [18].

Surova data vyexportovana z totilni stanice nejsou vhodnym vstupem pro uloZeni
objektu do 3D katastru. Problémem by byl velky objem dat. Stejné tak by tomu bylo
i v pfipadé FGM modelu, ktery je tvofen nepravidelnou trojuhelnikovou siti, i kdyz se

Vv tomto piipadé jiz jedna o na polygonech zalozenou 3D reprezentaci objektu.

U modernich staveb, kdy jsou zdi pravouhlé, svislé a hlavné rovné je zachyceni reality
mnohem jednodussi nez v piipad¢ staré¢ho sklepa, kde Zadna z téchto vlastnosti neplati.
Jednim z pfedpokladl pouzitelnosti potfizeného 3D modelu pro vyuZiti ve 3D katastru je
jeho generalizace. Jednalo by se napiiklad 0 zachyceni tvaru stropni klenby nékolika
navazujicimi polygony nebo o nahrazeni nerovnych stén a podlah rovinou

(2D polygonem).

Takovéto vysledky by mohly byt ulozeny do formatu pro ukladani 3D objekti (.obj,
.dae) a nasledné vyuzity pro 3D katastr, jak je popsano napiiklad v ¢lanku [19].

Sklepni prostory, zamétené pro Ucely této préce, jsou jist¢ vhodnym kandidatem pro
ulozeni do 3D katastru, jelikoz jeho hranice zasahuji do dvou riznych parcel. V tomto
konkrétnim piipadé sice neni nutné fteSit vlastnické vztahy, protoze jak cast pod

chodnikem, tak objekt nad sklepem patii obci, ale v minulosti tomu tak nebylo.
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7. POROVNANI MODELU Z LASEROVEHO SKENOVANI
A FOTOGRAMMETRICKEHO MODELU

Diplomova prace pojednava o dvou 3D modelech sklepa vzniklych dvéma raznymi
zpusoby. Prvnim z nich je model tvofeny bodovym mracnem z laserového skenovani
(dale téz LS model). Druhym modelem je fotogrammetricky model (dale téz FGM
model) vytvofeny z fotografii sklepa s vyuzitim zaméfenych vlicovacich bodda.
V nasledujicim textu jsou tyto modely porovnavany jak na zakladé prostorovych

odchylek téchto modelu, tak z pohledu ¢asové naroénosti jejich tvorby.

7.1. Vzdalenost ,,mracno vs. mra¢no“
Vzdalenost (prostorova odchylka), v tomto ptipadé¢ bodli jednoho mracna od mracna
druhého, je klasickou mirou rozdilnosti prostorové polohy dvou objektii. Pro vypocet
vzdalenosti mracna bodl z laserového skenovéani a mracna ziskaného fotogrammetricky

byl pouzit program CC, konkrétné funkce Compute cloud/cloud distance r

Vypocétena vzdalenost je neorientovana a byla zobrazena pomoci barevné skaly, a to ve
dvou variantach. Ze zobrazeni prvni varianty (obrazek 47), kde jsou vyraznéji odliseny
az vzdalenosti vétsi neZ cca 0,15 m, jsou dobfe patrna mista, kde chybi body zmé&fené
laserovym skenovanim (viz podkapitola 5.1). Detailni ukazka dosazeného extrému je na

obrazku 48.

Vzdalenost mracno vs. mraéno [m]

0.600
0.400

o

o
1
. 0.200
N 0.100
0.004
8.5

Obrazek 47: Vzdalenost "mra¢no vs. mra¢no"
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Volba stupnice byla opét velmi subjektivni — zvolit v tomto pfipadé pro znazornéni
pouze jednu barvu by dle mého nazoru nebylo vhodné, i kdyZz je zde vyjadfovéna
kvantitativni informace v podob¢ zvétsujici se vzdalenosti bodl. Barevny ton stupnice
jsem vybrala tak, aby mista s nepatrnou vzdalenosti ¢tenafe neupoutala na prvni pohled

a zaroven aby syté a jasné barvy upozornily na existujici anomalie.

Vzdalenost mracno vs. mracno [m]
0.60

0.40

0.20

0.10

0.00

4.5

Obrazek 48: Vzdalenost "mra¢no vs. mrac¢no" — detail

Druhy zpusob reprezentace dat se od prvniho zptisobu li§i Gpravou rozsahu stupnice.
Vzdalenost byla omezena pouze na 10 cm, coz umoznilo porovnani rozdilnych
vzdalenosti bodll v mistech, kde se nachazely body z obou mracen (obrazek 49). Pii
podrobnéjsim zkoumani se ukazalo, Ze zasadni vliv na vysledky vizualizace ma, kromé

vypoctené vzdalenosti mracen, pfedevsim hustota bodl laserového skenovani.

Vzdalenost mraéno vs. mracno [m]
0.10

0.08

0.06

0.04

0.02

0.00

8.5

Obrazek 49: Vzdalenost "mrac¢no vs. mraéno" — omezeni vzdalenosti
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Plocha FGM modelu, kterou Ize v CC vypoéitat pomoci Edit -> Mesh -> Measure
surface, je 510 m?. Podet bodi laserového skenovani je 566 575, z &ehoz vychazi jeden
bod na kazdy 0,0009 m?, primérnéa vzdalenost bodi LS je pak 0,03 m. Témto propo&tim

odpovida i histogram shodny s barvami stupnice na obrazku 49.

Druha varianta vizualizace, kterda méla zobrazovat prostorové odchylky mracen,
zobrazuje kombinaci odchylek a hustoty mracna. Pro zobrazeni prostorovych odchylek
dvou mracen bodi, které jsou srovnatelné nebo mensi nez primeérnd vzdalenost bodi,
neni tato metoda vhodna. Proto byla pro zobrazeni odchylek pouzita metoda

znazornujici vzdalenosti bodl od trojuhelnikové sité popsana v dalsi podkapitole.

7.2. Vzdalenost ,,mracno vs. TIN“
Software CC nabizi i pro tento tkon funkci, kterd dokaze vypocitat vzdalenost mezi
trojihelnikovou siti (TIN*) a mra¢énem bodéi (ikona /% Compute cloud/mesh
distance). V tomto piipadé do vypoctu vstupuje jako sit’ fotogrammetricky model

a mracnem bodid je mySleno mracno bodi z laserového skenovani. Diky vypoctu

vzdalenosti  bodi  od  sité ®
anastaveni barevné Skaly je *
kazdy bod obarven podle 4

orientované vzdalenosti od

roviny trojuhelniku. Nasledujici !
obrazek 50 ukazuje, ze pokud se

bod vyskytuje ve sméru normaly

povrchu, nabyva kladné hodnoty

a je obarven cCervenou barvou, @

pokud je vSak poloha bodu na  Obrazek 50: Princip obarvovani jednotlivych boda
opacné strané plochy

trojuhelniku, nez kam sméfuje normala, hodnota je zapornd a bod je obarven modre.
Sytost barev vyjadfuje absolutni hodnotu orientované vzdilenosti. Cim vétsi je
vzdalenost, tim vétsi je i sytost barvy. Nachazi-li se bod v roviné daného trojuhelniku, je

hodnota blizké nule a v tomto ptipad¢ bude bod charakterizovan Sedivym témbrem.

* TIN = Triangulated Irregular Network (nepravidelna trojihelnikova sit))
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Je zitejmé, ze vysledek je zdsadn€ ovlivnén orientaci normadl trojuhelnikd tvofticich
model. Normaly byly proto nastaveny obvyklym zpiisobem, tedy tak, aby smétovaly do
mista, odkud je mozné povrch pozorovat. V tomto piipadé tedy do vnitinich prostor

sklepa.

Tentokrat bylo zvoleno symetrické divergentni kvantitativni schéma a vybér barev jsem
podiidila kartografickému uzu, kdy modra barva znazornuje zaporné hodnoty, v tomto
ptipadé se jedna o body vyskytujici se na opa¢né strané, nez kam sméfuje normala,

a barva Cervena charakterizuje ¢isla kladna, tj. v kladném sméru orientace normaly.

Obrazek 51: Mra¢no obarvené na zakladé vzdalenosti "TIN vs. mra¢no"

Body na vétsich souvislych plochach, které jsou dobie vystihnuté fotogrammetrickym
modelem, jsou body obarveny podle skuteénych vzdalenosti od povrchu, coz odpovida
zaméru. Z obrazku 51 je patrné, ze dil¢i mra¢na ziskana z jednotlivych stanovisek na
sebe presné nesedi (viz podkapitola 5.1). TéZ je mozné si povSimnout ,,zakulaceni* roh
fotogrammetrického modelu, které se projevuje sytéjsi modrou barvou bodu v rozich. Na
celkovém pohledu bohuzel nejsou dobie patrné segmenty, kde vzdalenosti nabyvaji
extrémnich hodnot, proto budou nyni vybrany a detailnéji popsany nékteré tyto ¢asti

mracna.
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Osvétlent:

Jednou z nedokonalosti vytvoifeného fotogrammetrického modelu jsou tvary svétel.
V pribéhu potizovani snimkt, bylo osvétleni samoziejmé zapnuté, takze fotografie ¢asti
kolem zdroje svétla byly bud’ pfeexponované, nebo podexponované, coz bylo divodem

vzniku nepravidelnych obryst svétel v modelu (obrazek 52).

Obrazek 52: Interiér fotogrammetrického modelu - detaily svétel

Pro porovnani je zde pfiloZena i fotografie stejné ¢asti sklepa (obrazek 53).

Obrazek 53: Snimek podilejici se na vzniku ¢asti modelu
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Osvétleni ze zjevnych divodi nema vliv na funkénost laserového skenovani. Tvary
svétel byly tedy bez problému zaméfeny (Viz obrazek 54 a 55) a vysledkem vypoctu je

barevné odliseny rozdil mezi TIN a mra¢nem.

e

Obrazek 54: Mrac¢no bodu s detailem na osvétleni

Obrazek 55: Detail mra¢na bodu osvétleni
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Drevéna prepazka:

Dalsi a zéaroven nejvétsi odchylkou
vramci porovhavanych objektd byla
dievénd prepazka mezi prvnim patrem
sklepa a schody do druhého podzemniho
podlazi (obrazek 56). Z nasnimanych
obrazkl nebyl program Agisoft schopny
spravné zrekonstruovat realnou situaci

a tak jednotlivé laté nejsou

vymodelovany (obrazek 57). Obrazek 56: Fotografie dievéné piepazky

Obrazek 57: Snimek modelu zachycujici absenci dieveéné pricky

Na mracnu bodli se po vypoctu vzdalenosti tato skutecnost projevila nasledujicim

zpusobem (obrazek 58).
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Obrazek 58: Vzdalenost mra¢na od TIN v ptipadé dievéné prepazky
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Dvoukolovy vozik (tzv. karka):

V posledni ukazce, ktera bude piedvedena, se jedna
0 dvoukolovy vozik (dale jen karka). Ve sklepé se
tento objekt nachazel jiz davno pred naSim
ptichodem (obrazek 59) a pro zachovani ptivodniho
vzhledu a atmosféry celych prostor, zde byl
ponechan i Vv pribéhu sbéru dat. Laserovy paprsek
karku nékolika body zachytil, avSak Agisoft tvar
voziku kvuli subtilnosti jeho rdmu nedokazal
zrekonstruovat. Podobn¢ tomu bylo i v pfipadé

trubek vedoucich kolem stén.

Jak se rozdil v porovnavanych objektech projevil, Obrazek 59: Stara karka

ukazuje obrazek 60.

S 11:“*"’;#“;‘:;“—"“-;'._" :I [m]
.4-.'-.}-- 1,-_: ,'- 0 | 70
| s : 0.60
0 - 040
- P
T 2| 020
0.10
’ 0.00
i -0.10
-0.28

Obrazek 60: Vzdalenost "TIN vs. mra¢no" - karka
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Doposud probihalo zobrazovani odchylek mezi obéma modely (mezi mra¢nem boda
a TIN) pouze na dil¢ich castech, avSsak mnohem podstatnéjsi je zhodnoceni celkové
kvality fotogrammetrického modelu vi¢i mracnu bodii a to pomoci globélnich

charakteristik. Jedna se naptiklad o systematickou a nahodnou chybu.

Existuji postupy pro ur¢eni hodnoty nahodné a systematické chyby digitdlniho modelu
terénu (DMT) reprezentovaného trojuhelnikovou siti. Tyto postupy ale uvazuji pouze
chyby v jednom sméru (ve vysce) a nefesi chyby v poloze. V piipadé 3D modelu je ale
situace slozit&jsi, protoze je nutné uvazovat posun ve vsech souradnicovych osach, takze
napiiklad hodnota systematické chyby bude vyjadiena trojrozmérnym vektorem. Mezi
nahodné chyby by zde mohlo pattit napiiklad nedokonalé napojeni dil¢ich mracen bodu

nebo nepravidelny tvar trojihelnikové sit€¢ modelu.
Shranuti:

V této podkapitole bylo uvedeno nékolik piikladt, kdy se od sebe mra¢no laserové
naskenovanych bodu a trojuhelnikova sit’ fotogrammetrického modelu lisily nejvice.
Dutivodu, pro¢ k témto odchylkam doslo, je nékolik. Jednou z pfic¢in je nedostatecné
osvétleny prostor. Tvorba kvalitnich fotografii byla tak velmi obtizna a i pies veSkerou
snahu jsou nékteré snimky rozmazané ¢i zrnité. Problémy cinily 1 uzké prostory, ve
kterych nebylo mozné si od snimaného objektu poodstoupit a vytvofit tak pozadovanou
kvalitu digitalnich obrazkt. Nedokonalostmi modelu jsou pfevazné jen malickosti, jako

je napiiklad absence dievénych podpér (obrazek 61 a 62), které na vysledné vzezieni

nemaji zasadni vliv.

Obrazek 61: Snimek modelu Obrazek 62: Fotografie sklepa
(absence dievénych podpér) (dfevéné podpéry)
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V piipadé, Ze by byly znamy globalni charakteristiky odchylek modelt, by jiz existovalo
jakési meéftitko, jak TIN model odpovidd mracnu bodii z laserového skenovani, ale
Vv soucasnosti, kdy tuto chybu zatim nejsme schopni vypocitat, nelze zhodnotit, o kolik

se fotogrammetricky model odliSuje od naskenovaného mracna bodu.

7.3. Porovnani ¢asové narocnosti vzniku obou modeli
Zameéteni podzemniho bodového pole bylo nutnou soucasti tvorby obou modelti. Rozdil
ve sbéru dat ale spocival v laserovém skenovani mrac¢na bodi pro LS model (doba trvani
1 den) a pofizeni fotografii celého sklepa a naméfeni nékolika vlicovacich bodl pro

FGM model (1 den). Casova naro&nost sbéru dat pro oba modely je tedy shodna.

Zatimco vznik 3D modelu z naskenovaného mracna trva pii znalosti programu CC
priblizn¢ jednu hodinu, do které je zahrnut ¢as na Gpravu mracna (smazani nepotiebnych
bodt, spojeni dil¢ich mracen atd.) i doba potfebna pro vypocet normal a trojuhelnikové
sité, proces tvorby FGM modelu je zdlouhavé¢jsi. Odhadovana délka vytvofeni modelu

¢ini 15-20 h.

Mohlo by se zdat, ze tvorba modelu z mra¢na bodd byla o dost jednodussi a rychlejsi,
ale je nutné brat v potaz, ze FGM model je vytvofeny i S texturou, kdezto model
z mra¢na texturu nema, ¢imz ztraci na hodnoté v kvalité intepretace dat. Pokud bychom
chtéli model vytvofit 1S texturou, museli bychom na kaZzdém stanovisku, kde se
provadélo laserové skenovani, vytvofit i panoramaticky snimek. Tuto funkci Leica
MS50 obsahuje, ale jak jiz bylo uvedeno, kvalita fotografii nebyla pfimétend Casu, za
ktery byly snimky vytvofeny. Pokud by i tak panoramatické snimky byly vytvoteny,

FGM model by z hlediska ¢asové narocnosti vysel jako vitéz.

Uvedené porovnani vychdzi pouze z vlastnosti ptistroje Leica MS50. Neni mozné tedy
posoudit, jaké vlastnosti a moznosti pofizovani snimkii maji laserova zatfizeni urcena
pouze pro skenovani mracna bodl. Stejné jako je rozdilnd doba skenovani ve srovnani
kombinované totalni stanice s laserovym skenerem, je mozné, ze i1 kvalita a rychlost,

s jakou jsou snimky pofizovany, bude jina.
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8. DISKUZE

Na zobrazeni modelu vytvofeného z mra¢na bodd byla pouzita hypsometricka metoda.
Ne vzdy byla jeji barevnd Skala pouzita dle kartografického tuzu, ktery tika, ze
kvantitativni informace by mély byt vyjddieny pomoci zmény sytosti jedné barvy.
V piipad¢ vizualizace vzdalenosti mra¢na bodi od TINu bylo ale dle mého nazoru
vhodnéjsi pouzit zplsob pro kvalitativni data, tj. neomezit se pouze na vybér jedné
barvy. Vysledkem bylo piehledné zobrazeni vétSich rozestupi mezi body

a trojuhelnikovou siti.

Znézornéni mracna ve 2D bylo provedeno zobrazenim primétu do vodorovné roviny na
technickou mapu mésta Radnic. Na uplném pocatku bylo pocitano s tim, Ze pramét bude
vizualizovan na katastralni map¢, ale vzhledem k tomu, ze nas pfi zobrazeni nezajimaji
majetkové vztahy, ale spiSe jiné podzemni objekty, kterymi jsou hlavné inzenyrské sité,

byl nézor ptehodnocen a obrys sklepa byl zndzornén v technické mapé mésta.

Dalsim zptsobem, jak byla data reprezentovana, bylo porovnani obou modeld pomoci
vypoctu vzdalenosti, diky kterému bylo zjiSténo, ze celkového zhodnoceni kvality
modelu nejsme schopni. Problém je v rozsahlém nepravidelném uzavieném tvaru
objektu, u kterého klademe otazku, jak vypocitat systematickou chybu méfeni. Na
jednoduchych pravidelnych tvarech tyto vypocty jiz provedeny byly a to naptiklad
Vv bakalarské praci H. Kubickové [17], ale u ¢lenitych objektl, jakym byl isklep

v domové s pecovatelskou sluzbou, uz tak snadné feseni nalézt nelze.

V nésledujici ukézce je provedeno extrémni posunuti porovndvaného FGM modelu vici
LS modelu ve sméru osy ,z“smérem nahoru (obrazek 63), aby tak bylo mozné

prakticky demonstrovat problematiku vypoctu systematickych chyb.

Obrazek 63: Posun FGM modelu oproti LS modelu ve sméru osy "z"
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Po spusténi vypoctu vzdalenosti je na obrazku 64 mozné vidét, jak byly body obarveny.

Vzdalenost TIN vs. mrac¢no [m]
1012

0.500

0.000

-0.500

-1.038

Obrazek 64: Posun ve sméru osy "z" - obarvené mra¢no boda

V ptipad¢ DMT (2,5D) by body nad rovinou priniku TINu s mracnem bodu byly
cervené a body pod rovinou modré (s rliznou sytosti barev). V ptipadé sklepa se ale
pohybujeme pIné v prostoru a je nutné brat v potaz odchylky ve vSech soutadnicovych

osach.

Jak jiz bylo feceno v kapitole 7.2, body jsou obarvovany na zakladé své polohy vici
nejbliz8i ploSe trojuihelniku a podle orientace normaly k dané plose. Normaly, které ve
FGM modelu sméfuji dovnitt, ale rozhodné nejsou vzdy ve vodorovné poloze, a ne vzdy
se musi jednat o plochu, se kterou bychom chtéli bod srovnavat. Tyto skutecnosti jsou

dilezitymi faktory, na které by se pfi vypoctu systematické chyby mélo brat ohledy.

Na obrazku 65 je mozné si vSimnout, ze strop je Sice z pfevazné vétSiny obarven
cerveng, ale 1 na ném a hlavné po sténéch jsou patrné Sedivé oblasti. Jedné se o svislé
plochy modelu, kde se vyska bodl v rdmci posunu zmenila, ale vzdalenost boda viici

plocham na svislych sténach zistala stejna.
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Vzdalenost TIN vs. mraéno [m]
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Obrazek 65: Posun ve sméru osy "z" - pohled shora

Jde o to, Ze odhaleni systematické chyby v pfipadé DMT, kdy se jednd o posun pouze
V jednom sméru, je oproti zjiSténi stejné chyby ve 3D modelu, mnohem jednodussi. Pro
pln¢ uzaviené 3D objekty je ale zapotiebi vyuzit zcela jiny postup vypocti. Vytvoreni
konstruktu tohoto problému by mohlo byt vhodnym tématem pro dalsi vyzkum.
V soucasné dob¢ proto neni mozné jednoduSe zhodnotit, jak presny je FGM model ve

srovnani s LS modelem.
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9. ZAVER

V pribéhu diplomové prace byl zaméfen rozsahly podzemni komplex sklepa. Objekt se
nachazi na namésti Kagpara Sternberka, ¢. p. 242 a v soudasnosti je vyuZivan jako
domov s pecovatelskou sluzbou. Pro zaméteni bylo vyuzito nékolik geodetickych metod.
Jednalo se o0 metodu RTK, zaméfeni oboustranné pfipojeného a oboustranné
orientovaného polygonového poradu (PP) a laserového skenovani mrac¢na bodt. Dalsi

¢innosti spocivaly ve zhotoveni fotografii celého sklepeni ¢i zaméteni vlicovacich bodd.

Pti méfeni PP bylo nutné vyporadat se S nizkou kvalitou osvétleni, izkymi chodbami
a v nékterych mistech i nizkymi stropy. Nedostatek svétla byl vyfeSen osvétlenim
nitkového kiize (funkce totalni stanice) a pfidanou svitilnou, kterou figurant osvétloval
hranol pro pfesnéjsi zacileni. Postaveni stativu bylo velmi rozmanité a Vv extrémnich
ptipadech az komické, ale nastrahy sklepnich prostor byly pifi méfeni PP se cti
prekonany. Dalsi tskali byla spojena slaserovym skenovanim mra¢na bodd. Bylo
zapotiebi poradit si s minimalni vzdalenosti, na kterou je pfistroj schopny snimané
objekty zaméfit, coz v izkych chodbach nebylo jednoduché. Prestoze bylo skenovani
provadeéno z celkem 18 stanovisek, jejichZ rozmisténi byla vénovana znacna pozornost,

vyskytla se ve skenovanych datech mista, kde mra¢no bodt neni celistvé.

StéZejnim cilem prace bylo hledani zplsobl, jak co nejvhodnégji reprezentovat
naskenované mracno bodl. Zpracovani mracna pocinalo vytvoifenim nepropustného
modelu pomoci vypoétu normal a Poissonova algoritmu. Vysledny model byl pouzit pro
znazornéni vyskovych pomért, kcemuz byla zvolena hypsometrickd metoda.
Vicebarevna verze tohoto zplsobu vizualizace vySkovych vlastnosti od sebe odliSuje
Casti vyskytujici se pod a nad povrchem zemé.s Z pouzité barevné Skaly je uzivatel
schopen poznat, vjaké vysce se napiiklad nachazi podlahy prvniho ¢i druhého
podzemniho patra nebo pii pohledu na primét modelu do vodorovné roviny shora je

mozné sledovat pribéh stropni klenby.

Béhem tvorby diplomové prace vznikl 1 fotogrammetricky model. Jeho autorem je
vedouci Ing. R. Fiala, Ph.D. Tento model byl porovnan s naskenovanym mracnem bodd,
a to dvéma zplsoby. V prvnim piipad¢ se jednalo o srovnani vzdalenosti mezi laserové
naskenovanym mracnem a mracnem fotogrammetrického modelu a v ptipad¢ druhém

Slo o porovnani mracna z laserového skenovani viici trojuhelnikoveé siti.
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Obé¢ wuvedené wvarianty srovnani nalezneme | V bakalaiské praci kolegyné
Bc. H. Kubickové. Zde se vSak jedna o komparaci modelu pravidelného movitého
predmétu, u kterého bylo mozné na zakladé¢ matematickych vztahd zhodnotit kvalitu
vzniklého FGM modelu. V. mém piipadé je ale zkoumany objekt velmi rozsahly
anepravidelny a postupy uvedené ve vyse zminéné bakaldiské praci neni mozné
aplikovat na tuto situaci. Pro celkové zhodnoceni pfesnosti vytvoreného
fotogrammetrického modelu by bylo zapotiebi urcit globalni charakteristiky piesnosti,
jako jsou napfiiklad systematicka a ndhodna chyba. Vypocty podobnych charakteristik
ale nejsou pro pln€ 3D objekty trividlni a nelze pouzit postupit zndmych naptiklad pro
digitalni modely terénu, kdy je hodnocena pouze odchylka v jednom sméru (ve vysce).
Definice vhodnych charakteristik pfesnosti a zptsob jejich vypoctil je namétem pro dalsi

vyzkum.

V tvodu diplomové prace byly vymezeny cile, kterych jsem chtéla v pribéhu tvorby
doséhnout. Jednalo se o geodetické zaméteni sklepnich prostor, kde hlavni ¢innosti pro
splnéni tohoto cile bylo zaméfeni polygonového pofadu. StéZejnim cilem bylo zobrazeni
naskenovaného mra¢na bodu jak ve 3D tak i ve 2D. Ke splnéni tohoto zavazku byla
pouzita metoda zvand hypsometrie, kterd je vhodnd pro odborné Etenafe. Vicebarevné
Skaly nabizeji nepfeberné mnozstvi variant, jakymi lze rozdilné reprezentovat totoZna
data. Pro laiky je pak nejptinosnéjsi zobrazeni takové, jaké se nejvice blizi realité. Tim
je fotogrammetricky model s texturou. Porovnani technické mapy mésta s primétem

sklepa do vodorovné roviny bylo dal$im zptisobem zobrazeni dat, tentokrat ve 2D.

Zadani prace a vSechny vymezené cile byly pfi tvorbé této diplomové prace naplnény.
ReSeni prace, a zejména meéteni ve sklepich, pfineslo fadu zajimavych a uzite¢nych

zkuSenosti.
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Struktura DVD

Adresafe na pfilozeném DVD jsou pojmenovany stejné jako kapitoly, ke kterym se

vztahuje jejich obsah (bez hackt a ¢arek):

,,Diplomova_prace_Jerabkova‘“ — text diplomové prace ve formatu pdf

3. VLASTNI MERENI A VYPOCTY

3.1.

3.3.

3.4.

3.5.

Georadarovy prizkum

,radnice 77" — ZéavéreCna zprava (Geofyzikalni prizkum pro vyhledani
podzemnich objekti)

Polygonovy porad a trigonometrické urcovani prevySeni

,,zapisnik “ — zapisnik celého terénniho méfeni

Vypocty namérenych dat
,,souradnice “ — seznam vypoctenych souradnic
Laserové skenovani

,,mracno “ — laserové naskenovaném mrac¢no boda

4. ZPRACOVNANI ZISKANYCH DAT

4.2.

4.3.

Tvorba modelu v programu Agisoft PhotoScan

, FGM model “ — vysledny fotogrammetricky model

Tvorba modelu v programu CloudCompare

, LS model 16“— model vypocteny Poissonovym algoritmem

5. ZPUSOBY INTERPRETACE DAT

5.1.

5.2.

Hypsometrie
LS model jednobarev hyps“ — model jednobarevné hypsometrie

,, LS model vicebarev_hyps‘“ — model vicebarevné hypsometrie

Zobrazeni sklepa v technické mapé
,projekt tech_ map* — QGIS projekt — zobrazeni priméru sklepa v technické

mapé
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e Slozka ,, vstupy “ — obsahuje vstupni vrstvy projektu

6. POROVNANI MODELU Z LASEROVEHO SKENOVANI
A FOTOGRAMMETRICKEHO MODELU
6.1. Vzdalenost ,,mracno vs. mra¢no*
o cloud cloud*” — obarvené mracno dle vypoctu  vzdélenosti
,,mrac¢no vs. mra¢no*

e cloud cloud limit*“— obarvené mra¢no s omezenou vzdalenosti

6.2. Vzdalenost ,,mracno vs. TIN“

o cloud TIN“ — obarvené¢ mracno dle vypoctu vzdalenosti ,,mracno vs. TIN*
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